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Please read this [User’s Guide] carefully in advance to 
ensure proper use of this product.

� JVC ProHD Clip Manager software
● JVC ProHD Clip Manager is a software for operating MP4 

file format clips recorded using recorder devices that 
make use of JVC’s ProHD series memory cards.

● This software can be used to copy clips recorded on the 
memory card to destinations such as computer hard 
disks, as well as to organize existing clips. Other possible 
operations include converting the format of clip files, 
previewing the clip content, and also viewing the 
metadata that comes with the clip.

Memo：                                                                                 
● It is recommended that all materials recorded on the 

memory card using a ProHD series recorder be backed 
up and made easily retrievable in future by copying them 
to the hard disk of the computer.

● The following procedure is recommended to ensure that 
materials on the memory card are safely copied.
A Create a new folder for each memory card in advance
B Copy all materials on the memory card to the folder 

created in A
C To copy materials from another memory card, create a 

new folder, and copy the materials to it
● For details on how to safely copy the materials on the 

memory card, please read the following:
● Windows: (A page 9_25)

                                                                                                     
● Mac : (A page 30_46)

� Main functions of the JVC ProHD Clip Manager 
software
● Operations on MP4 file format clips

● Copying clips (copying all or any random clip on the 
memory card, etc.)

● Moving or deleting clips
● Previewing clip content
● Viewing and operating the metadata of a clip

● Managing folders in which clips are stored
● Creating new folders
● Deleting, splitting, or combining folders

How to Read this User’s Guide

� Symbols used in this manual
Note : States precautions to be taken during 

operation.
Memo : States restrictions on the functions or use of 

this equipment. For reference purposes.
A : Indicates the page numbers or items to refer to.

� Contents of this manual
● JVC holds the copyright to this manual. Any part or all of 

this manual may not be reproduced without prior 
consent from the company.

● Design, specifications and other contents described in 
this manual are subject to change for improvements 
without prior notice.

� Copyrights
● Microsoft, Windows and Microsoft Vista are either 

registered trademarks or trademarks of Microsoft 
Corporation in the United States and other countries.

● Mac OS is trademark of Apple Inc., registered in the 
United States and other countries.

● Intel, Pentium and Core are registered trademarks of 
Intel Corporation in the United States and other 
countries. Core is a trademark of Intel Corporation in the 
United States and other countries.

● Product names of other companies described in this 
manual are trademarks or registered trademarks of the 
respective companies. Symbols such as �, � and � are 
omitted in this manual.
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Getting Started

Please carefully read this End-User License Agreement ("Agreement") before installing the JVC ProHD Clip Manager 
("Software") into your computer. The right to use the Software is granted by Victor Company of Japan, Limited ("JVC") to end 
user (“You”) only on the condition that You agree to the following Agreement.
If You do not agree to the terms of the Agreement, you may not install the Software. INSTALLING OR USING THE SOFTWARE 
INDICATES YOUR ACCEPTANCE OF THE TERMS AND CONDITIONS OF THE AGREEMENT. The Software also includes the 
associated materials, and any modifications, upgrades and updates of the Software granted to You by JVC.

END-USER LICENSE AGREEMENT
1 Copyright; Ownership
You acknowledge that all copyrights and other intellectual property rights in the Software are owned by JVC and its licensor(s), 
and remain vested in JVC and such licensor. The Software is protected under the copyright law of Japan, the United States, other 
countries, and related Conventions.

2 Grant of License
A Subject to the conditions of the Agreement, JVC grants to You a non-exclusive right to use the Software with JVC’s HD Memory Card 

Camera Recorders or Memory Recorders.
B You may install and use the Software on a HDD or other storage devices incorporated in Your computer.
C You may make a copy of the Software for back-up and storage purposes.

3 Restriction
A You may not modify, reverse-engineer, decompile or disassemble (except to the extent as permitted by the applicable laws) the Software 

in any manner.
B You may not copy or use Software, in whole or in part, other than as expressly specified in this Agreement.
C You have no right to grant a license to use the Software, and may not sell, lease or rent the Software to any other person for any purpose.

4 Limited Warranty
THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. JVC MAKES NO WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. SHOULD THERE BE ANY PROBLEM ARISING FROM OR CAUSED BY THE SOFTWARE, YOU SHALL BE 
RESPONSIBLE FOR RESOLVING ALL SUCH PROBLEMS AT YOUR OWN COST.

5 Limitation of Liability
JVC SHALL HAVE NO LIABILITY WITH RESPECT TO THIS AGREEMENT OR OTHERWISE FOR CONSEQUENTIAL, 
EXEMPLARY OR INCIDENTAL DAMAGES EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES 
RELATING TO THE SOFTWARE. YOU WILL INDEMNIFY AND HOLD HARMLESS JVC FROM ANY LOSS, LIABILITY OR 
COSTS ARISING OUT OF OR IN ANY WAY CONNECTED TO CLAIMS FROM ANY OTHER PERSONS RELATING TO THE 
USE OF THE SOFTWARE.

6 Term
A This Agreement will become effective on the date when You install the Software into Your computer, and continue to be in effect unless 

terminated pursuant to Article 6.2.
B Should You breach any provision of this Agreement, JVC may immediately terminate this Agreement upon notice to You. In this event, JVC 

may claim against You any damages caused by Your breach. Should this Agreement be terminated, You should immediately destroy the 
Software stored in Your computer (including erasing it from any memory in Your computer).

7 Export Control
You agree that You will not ship, transfer or export the Software or underlying information and technology to any territories or 
parties which are restricted or prohibited by the applicable laws of Japan and other relevant countries.

8 U.S. Government User
If You are an agency of the United States of America (the "Government"), You acknowledge JVC's representation that the 
Software is a "Commercial Item" as defined in Federal Acquisition Regulation (FAR) part 2.101 (g) consisting of unpublished 
"Commercial Computer Software" as those items are used at FAR part 12.212 and is only licensed to You with the same use 
rights JVC grants all commercial end users pursuant to the terms of this Agreement.

9 General
A No modification, change, addition, deletion or other alteration of or to the Agreement will be valid unless reduced to writing and signed by 

an authorized representative of JVC.
B To the maximum extent permitted by the applicable law where the Software was acquired, any conditions or warranties imposed or implied 

by law are hereby excluded. You may nevertheless have the benefit of certain rights or remedies pursuant to the applicable law in respect 
of which liability may not be excluded. In any case, however, JVC's entire liability will be limited to the replacement of the defective media 
containing the Software within six (6) months after Your acquirement of the Software.

C Even if any part of the Agreement is held invalid by or in conflict with any law having jurisdiction over this Agreement, the remaining 
provisions will remain in full force and effect.

D The Agreement shall be governed by and interpreted under the laws of Japan. The Tokyo District Court has jurisdiction over all disputes 
which may arise with respect to the execution, interpretation and performance of this Agreement.

End-User License 
Agreement
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For Windows

Install this application on a computer meeting the following 
hardware and software requirements.

Installing from the CD-ROM
1 Insert the bundled CD-ROM into the CD-ROM 

drive of your computer

2 Open the CD-ROM using My Computer and run 
the [Setup. exe] located in the following folders: 
[Software]B[ClipManager]B[Windows]B[English]

● The setup wizard appears. Follow the on-screen 
instructions to complete the installation.

● The End-User License Agreement screen will appear, 
read the agreement and click [Agree] to proceed with the 
installation.

● If the [.NET Framework 2.0] setup screen appears, read 
the license agreement and click [Agree] to install [.NET 
Framework 2.0].

To Uninstall the Application
Select [Add or Remove Programs] in the Windows [Control 
Panel], and then select [JVC ProHD Clip Manager] from the 
list of installed programs and click [Delete].

Launching the Application
Double click the shortcut icon on the desktop. The 
application starts, and the operating windows appear. 
(A Page 6)

Exiting the Application
Do one of the following:
● Select [Close] from the [File] menu.

● Click the [ × ] (close) button in the upper right of the 
operating window.

Note：                                                                                
● Do not power off the computer while a file operation is still 

underway. Files may be corrupted. Wait until the 
operating finishes, or cancel the operation, before 

                                                                                                     
powering off.

Operating Environment

Item Requirement

Processor Intel Core 2 Duo 2 GHz or higher 
recommended

Memory 2 GB or more recommended

OS Microsoft Windows XP SP3 or higher, or 
Microsoft Windows Vista SP1 or higher 
(32-bit version)

Installing the Application

Launching and Exiting the 
Application
5



For Windows

Operating Window Configuration
 (A Page 22 AOption SettingsB)

Memo：                                                                                                                                                                                          
● You can customize the window configuration by resizing or moving the window according to the operating environment of the 

various Info windows. (A Page 7)
● To return to the default configuration, select [Default position] from the window menu.
● The application remembers your most recent configuration and recreates it the next time it starts.

                                                                                                                                                                                                                       
● The Viewer window cannot be resized. However, you can click on the maximize button during playback to play in full screen.

Name and Function of 
Parts

Title bar Menu bar Viewer window

Info windows
6



Info Windows
These windows display the clips in the media and folders. 
You can view, copy or delete the clips. Two Info windows are 
displayed by default. Clips from the memory card can 
therefore be easily copied to the hard disk by dragging and 
dropping the icon of the clip. The configuration of Info 
window is as follows:

Note：                                                                                 
● Information in Info windows does not display properly if 

the selected font does not support the character code set 
used in the software operating environment. Before 
displaying information in the Info windows, select an 
appropriate font and character code set in the Options 
dialog.

● Carriage returns may be displayed for some fonts.
For details, please refer to AOption SettingsB 

                                                                                                     
(A Page 22).

A Media name, Used capacity
Displays the media name assigned to the media or folder, 
and the capacity used by clips and their related data in the 
currently selected media or folder.

B Toolbar
Contains tool buttons for operations on clips and folders.

C Tree View pane
Displays two levels of the tree structure of removal media or 
folders in the hard disk drive. A folder in the lower level can 
be double clicked to make it the root folder and display the 
level beneath that folder. When you click a media item or 
double click a folder, the clips in the media or folder appear 
in the List View pane.

D Capacity
Displays the total capacity and remaining capacity of the 
media selected in the Tree View pane. The remaining 
capacity is shown as a numeric value and as a bar graph. 
The orange bar grows longer as more of the media’s 
capacity is used.Tool buttons

Function Reference
Icon Name

Create 
New 
Folder

Creates a new folder 
in the currently 
selected location.

A Page 11

Search Opens the clip search 
screen, and allows 
you to search a clip by 
title or date.

A Page 19

Up Moves up to the next 
folder.

^

A

C

E

B

D

Tool buttons
Function Reference

Icon Name

Change 
Root 
Folder

Changes the root 
folder in the Tree 
View pane.

^

Split Splits a folder 
according to the size 
selected.

A Page 12

Tree 
View

Shows or hides the 
Tree View pane.

^

Copy All Copy all of the clips in 
the current media or 
folder.

A Page 13

List view 
setting

You can select from 
the following list view 
modes.

: Details
: List

: Thumbnails

^
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For Windows

E List View pane
Displays the clips in the media or folder that is selected in the 
Tree View pane.
You can select from the following three view modes in the list 
view setting under B Toolbar:  Details,  List and  
Thumbnail.

A mark indicating the status of the clip is display on the 
thumbnail shown as follows. This also applies to List/Details 
view.

T1 : Clips with OK status can be moved or deleted by this 
application.

T2 : A video that exceeds 4 GB will automatically be 
saved as multiple clips. These clips are parts of the 
complete recording and can be saved on multiple 
media. All of the original recorded video is not played 
back when a split clip is played back.

T3 : A clip that cannot be played or displayed properly by 
this application. The file may be corrupted, file links 
may be broken or changed, required files may be 
missing, or thumbnail creation may have failed.

T4 : When another application is using the clip file.

Viewer Window
This window is where you preview clips. You can use the 
preview control buttons to playback, fast forward or fast rewind.

A Screen
Displays the playback video.

B Position bar
Displays the current position in the clip. You can move to any 
position in the clip by dragging the knob or by clicking directly 
on the position bar.

C Timecode
Displays the timecode of the position bar and the duration of 
the clip.

Note：                                                                                
● The counter operates at 25 fps for unregistered clips.

                                                                                                     
● The count for import clips starts at 00:00:00:00.

D Preview control buttons
These are buttons for controlling clip previews. The buttons 
(starting from the leftmost button on the screen) and their 
functions are as follows.

Fast Rewind button : Search back from the current position 
(rewind).

Single Frame Reverse button

: Step back 1 frame.

Stop button : Stop at the current position.

Play button : Start play.

Single Frame Forward button

: Step forward 1 frame.

Fast Forward button: Search forward from the current 
position (fast forward).

Move to First Frame button

: Go to the first frame of the clip.

Move to Last Frame button

: Go to the last frame of the clip.

Name and Function of 
Parts (continue)

View mode Icon Description

Thumbnails 
view

Normal clip

Clip with OK status (as 
set on the recorder) T1

One of the smaller 
clips into which a 
longer recording has 
been split (a frame is 
displayed around it) T2

 Imported MP4 clip

Unregistered MP4 clip 
(clip that has not been 
imported)

Abnormal clip T3 T4

A

B

C

D

E

F
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E [Audio CH] (Audio channel) selection buttons
Click the [Stereo]/[Monaural] button to switch between the 
Stereo and Monaural modes. When [Stereo] is displayed, 
audio is output from both channels. When [Monaural] is 
displayed, audio can be output by selecting CH1 or CH2.

F [Index Picture] button
Sets the index picture of the current preview clip to a still 
image of the currently displayed frame. However, setting 
performed using this button will not be applied to the 
thumbnail display on the device.

Note：                                                                                 
● Playback in this window is preview playback. Note the 

following points:
● Depending on the performance of your computer and 

the processing load, dropped frames may occur and 
timecode may differ from the actual values.

● When the playback clip is defective, video breakup 
may occur and the playback may freeze.

● All of the original recorded video is not played back 
when a split clip is played back.

● It may not be possible to play clips created on devices 
other than the device you are using.

● If the colors of the playback video are not normal, exit 
the software and try adjusting the color parameters in 
the Properties window of your desktop screen. It may 
be possible to restore normal colors.

● Improper playback may occur if the screen properties 
of your computer are changed during playback. If this 
occurs, restart the application.

● The video may not appear on both monitors when you 
try to display it on the computer’s monitor and an 
external monitor, for example when using a laptop 

                                                                                                     
computer.

This section describes the procedures for operating clips that 
are recorded in the MP4 file format, which is supported by 
this software.

Note：                                                                                
● Make sure that operations such as copying and deletion 

of clips are performed using this application. The recorded 
video/audio clips (MP4 files) come with other information 
files. Operating the clips via other means may therefore 

                                                                                                     
cause problems that prevent proper file management.

The basic procedures for operating the clips are as follows:

K

K

Procedures for Operating 
Clips Using Clip Manager

Step 1

Selecting Work Media and Work 
Folders (A Page 10)
Select the media or folder in which the clips 
are stored, and display the corresponding Info 
window.

Step 2

Folder and Media Operations 
(A Page 11)
Select the folder to be manipulated, such as 
the folder to copy files to, or create a new 
folder.

All clips inside a media/folder can be copied or 
backed up.

Step 3

Clip Operations (A Page 14)
Make use of the toolbar buttons and other 
buttons to perform the necessary operations, 
such as copying, moving, or deleting clips 
stored in a media/folder.
9



For Windows

This section explains how to select the media or folder that 
contains the clips you want to work with.

There are two ways to select them, by using the Tree View 
pane of an Info window, or by using the Change Root Folder 
dialog.

Memo：                                                                                 
● In this manual, “media” refers to the following media 

types:
● SxS memory card
● USB memory
● SDHC memory card
● Internal hard disk
● Externally connected hard disk
● CD-R
● DVD-R

                                                                                                     
● Blu-ray Disc

To Select in the Tree View Pane

1 In the Tree View pane of an Info window, double 
click the media or folder that you want to select

● The level beneath the double clicked media or folder 
appears. The Tree View pane displays two levels, 
consisting of the media or folder itself and the next lower 
level.

● When there are clips saved directly to the top level of the 
media, they appear in the List View pane.

2 Double click a lower-level folder

● The double clicked folder becomes the root folder, and its 
lower level folders appear.

� To return to the next higher level
Select [Up] from the [View] menu, or click the Up button in 
the toolbar.

3 Repeat step 2 as required

● The contents of the selected folder appear in the List View 
pane.

To select in the Change Root Folder 
dialog

1 Open the [Change Root Folder] dialog by 
selecting [Change Root Folder] from the [View] 
menu, or click the Change Root Folder button in 
the toolbar

2 In the Tree View pane of the dialog, select a 
media item or folder

3 Click [OK]

● The [Change Root Folder] dialog closes, and the contents 
of the selected media or folder appear in the List View 
pane.

� When there are no clips in the selected media or 
folder
If the List View pane is in Thumbnails View mode, nothing 
appears in the List View pane.

If it is in List View or Details View mode, a message appears 
saying that there are no clips to display.

Note：                                                                                
● When you select a media item, a message may appear 

saying that AThe work folder or media needs to be 
repaired.B, and that ARestore on the recording deviceB. 
This message appears when the data is defective, 
typically because the device was powered off during 
recording, or because the media was ejected too soon. If 
this message appears, you should reinsert the media into 
the device and attempt to salvage it as soon as possible. 
The data may become unrecoverable if you continue to 

                                                                                                     
work with it without salvaging it.

Selecting Work Media and 
Work Folders
10



Note：                                                                                 
● Always observe the following precautions during 

processing of folder and media operations:
● Do not power off the computer or media drive before 

the operation completes.

                                                                                                     
● Do not eject the media before the operation completes.

Clip Folders for MP4 File Format
The clips are stored together with a BPAV folder 
(A Page 21). (This folder does not appear in the Info 
windows, but it can be seen in Windows Explorer.)
Whenever you copy or move clips with this application, copy 
or move the BPAV folder along with the clips. You cannot 
work with clips separately from the BPAV folder.

Note：                                                                                 
● Simultaneous access to files may not be possible when 

you attempt to access the same folder at the same time 

                                                                                                     
from several computers over a network connection.

Creating Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the media or open the 
folder where you want to create the folder, making 
it the root folder of the Tree View pane

2 With the root folder having the focus, select 
[Create New Folder] from the [File] menu, or click 
the [Create New Folder] in the toolbar

● A new folder is created on the selected media or in the 
selected folder in step 1.

� Reasons why folder creation may fail
Folder creation operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not created.

● You do not have write privileges for the media or folder 
selected in step 1.

● The media or folder selected in step 1 is write protected.

Note：                                                                                
● A new folder for storing files cannot be created in a folder 

where clips are already stored. Create a folder at a 
location that is at least two levels higher.
Example: With the Archive folder as the root work folder, 

new folders can be created at the higher level 
for each media or administrative classification 
(Media1, Media2, etc.).

● New folders cannot be created using [My Computer] as 
the root folder.

● Folders cannot be created when this is not allowed by the 
computer file system.

● Immediately after they are created, new folders are 
normal folders. But when even one clip is copied or 
moved to the new folder, the folder is formatted as an 
work folder with the same format as the device in use. 
(The required subfolders and metadata files are created 
automatically.)

● The name ABPAVB is reserved and cannot be specified.
● Characters forbidden by the operating system and the A$B 

                                                                                                     
character cannot be used in folder names.

� To rename a folder

1 Select the newly created folder, and then select 
[Rename] from the [File] menu

● The [Rename] dialog appears.

2 Enter the new name in the edit box (up to 80 
alphanumeric characters and symbols)

Note：                                                                                
● The name ABPAVB is reserved and cannot be specified.
● Characters forbidden by the operating system and the A$B 

                                                                                                     
character cannot be used in folder names.

3 Click [OK]

Folder and Media 
Operations
11



For Windows

Creating Folders (continue)
� To back up folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the folder that you 
want to back up

2 Select [Open Containing Folder] from the [File] 
menu
● The Windows Explorer appears.

3 Perform your backup operations in Explorer
When a folder is too large to save to your backup media
You can split the folder into smaller folders, which can be 
saved on separate discs. Split folders can later be combined 
to restore the original large folder.

Memo：                                                                                 
● For details, refer to ASplitting FoldersB (A Page 12) and 

                                                                                                     
ACombining FoldersB (A Page 13).

Deleting Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the folder to delete

2 Press the Delete key, or select [Delete] from the 
[Edit] menu

Reasons why a folder deletion may fail
Folder deletion operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not deleted.
● You do not have delete/write privileges for the selected 

folder.
● The selected folder is write protected.
● Clips or other folders exist beneath the folder. T1

Note：                                                                                 
● Be careful when deleting folders, because all data in the 

folder is deleted.

                                                                                                     
● Deletions cannot be undone after they finish.

T1 : The following shows two situations in which a folder 
cannot be deleted
● When there is a file that is not linked to the object 

folder
● When there is another folder besides the object 

folder
In these cases, the file which is not linked to the 
object folder and any other folder must be deleted 
beforehand.

Splitting Folders
You can split large folders into smaller folders. This allows 
you to back up all of the clips in a large folder to media that is 
not large enough to save the entire folder without splitting.
For example, you can split an 8 GB folder into two 4 GB 
folders in order to save them on 4 GB DVD-R media. Note 
that individual files in the large folder are not split.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the folder to split

2 Select [Split Folder] from the [Edit] menu, or 
click the Split Folder button in the toolbar

● The [Split Folder] dialog appears.

● Note that individual files in the large folder are not split. 
Clips are assigned to the split folders in such a way that 
the split folders have the specified size. This means that it 
is not possible to specify a split folder size smaller than 
the largest file in the original folder.

● It is also not possible to specify a split folder size smaller 
than 4 GB.

3 Select the size of the split folders from the 
drop-down list

4 Click [Start]

● You can select from 4 GB to 60 GB in increments of 4 GB.
● The folder is split into the minimum number of folders that 

will produce the specified folder size, and clips are 
assigned to the smaller folders. The folders produced as a 
result of the split have the same name as the original 
folder, followed by serial numbers.

Note：                                                                                
● Once it starts, a split operation cannot be canceled before 

it finishes.
● Split clips may be assigned to different folders. If you 

would prefer that split clips be assigned to other folders, 

                                                                                                     
you can move them manually after the folder split.

Folder and Media 
Operations (continue)
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Combining Folders
You can combine specified folders into another folder. This 
allows you to restore the original folder from split folders.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the destination folder 
into which the other folders will be combined

2 Select [Combine Folder] from the [Edit] menu

● The [Combine Folder] dialog appears.

3 Check the check boxes of the folders that you 
want to combine into the folder selected in step 1.
Check the [Delete the folder(s) after folder 
combination.] check box if you want to delete the 
combined folders after the combine.

Note：                                                                                 
● The combined folders are not deleted when:

● They contain other folders.
● You do not have delete/write privileges to the original 

folders.

                                                                                                     
● The folders are write protected.

4 Click [Start]

● The folders selected in step 3 are combined into the 
destination folder specified in step 1. The clips in all of the 
folders are gathered into the destination folder.

● If any of the clips are split clips, they are automatically 
grouped, allowing them to be handled as a single clip.

� Reasons why a folder combine operation may fail
Folder combine operations may fail for the following reasons. 
In these cases, an error message appears and the combine 
is not executed.

● There is not enough free capacity in the combine 
destination folder.

● You do not have write privileges to the source or 
destination folders.

● The source or destination folder is write protected.
● Multiple instances of the same clip exist.

Copying All the Clips in Media or Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select a copy source media 
or folder in one of the Info windows

2 In the other Info window, select a copy 
destination media or folder

3 Activate the copy source Info window, and 
select [Copy All] from the [Edit] menu or click the 
Copy All button in the toolbar

● The [Copy All] dialog appears.

4 Check [Copy from：] and [Copy to], and then 
click [OK] to execute the copy
Or click [Cancel] to cancel it

� To change the copy destination
Click the [Copy from：] box to highlight it, and enter a folder 
name as the new copy destination.

● When the copying starts, a progress dialog appears to 
display the status of the copy task.

� To cancel the copy
Click [Cancel] in the progress dialog.

� Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In these 
cases, an error message appears and the copy is not 
executed.

● There is not enough free capacity at the copy destination.
● A clip with the same name as one of the copied clips 

already exists at the copy destination. Even if the titles are 
different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the source or 
destination media or folders.
13



For Windows

Note：                                                                                 
● Always observe the following precautions during 
processing of clip operations.

● Do not power off the computer or media drive before 
the operation completes.

● Do not use Windows Explorer or other file 
management tool to delete folders that contain the 
clips being processed.

                                                                                                     
● Do not eject the media before the operation completes.

Copying Clips
You can duplicate clips on your media or computer, and copy 
clips between the media and the computer.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), display the clips that you 
want to copy in one of the Info windows

2 In the other Info window, select a copy 
destination media or folder

� If you want to copy the clips to a new folder
Create a new folder in the copy destination media or folder.

Memo：                                                                                 
● For details on how to create folders, please refer to 

                                                                                                     
ACreating FoldersB (A Page 11).

3 Select the clips to copy in the copy source 
window

� To select multiple clips

Note：                                                                                 
● Click the clips one after the other with the Ctrl key held 

down.
● Unregistered clips and abnormal clips can be selected, 

                                                                                                     
but they are not copied.

4 Do one of the following

● Drag the selected clips and drop them in the List View 
pane of the Info window of the copy destination media or 
folder.

● Select [Copy] from the [Edit] menu. Then click the Info 
window of the copy destination media or folder and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the copy.

5 Check [Copy from：] and [Copy to], and then 
click [OK] to execute the copy
Or click [Cancel] to cancel it

When the copying starts, a progress dialog appears to 
display the status of the copy task.

Note：                                                                                

                                                                                                     
● Once it has been completed, a copy cannot be undone.

� To change the copy destination
Click the [Copy from：] box to highlight it, and enter a folder 
name as the new copy destination.

� To cancel the copy
Click [Cancel] in the progress dialog.

� Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In these 
cases, an error message appears and the copy is not 
executed.

● There is not enough free capacity at the copy destination.
● A clip with the same name as one of the copied clips 

already exists at the copy destination. Even if the titles are 
different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the copy 
destination media or folders.

● The copy destination media or folder is write protected.

Clip Operations
14



Moving Clips
You can move clips on your media or computer, or move 
clips between the media and the computer.

Note：                                                                                 
● Clips with OK status can be moved by this application. 

                                                                                                     
(A Page 8)

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), display the clips that you 
want to move in one of the Info windows

2 In the other Info window, select a move 
destination media or folder

� If you want to move the clips to a new folder
Create a new folder in the move destination media or folder.

Memo：                                                                                 
● For details on how to create folders, please refer to 

                                                                                                     
ACreating FoldersB (A Page 11).

3 Select the clips to move in the move source 
window

� To select multiple clips
● Click the clips one after the other with the Ctrl key held 

down.

Note：                                                                                 
● Unregistered clips and abnormal clips can be selected, 

                                                                                                     
but they are not moved.

4 Do one of the following

● Drag the selected clips with the Ctrl key held down and 
drop them in the List View pane of the Info window of the 
move destination media or folder.

● Select [Cut] from the [Edit] menu. Then click the Info 
window of the move destination media or folder and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the move.

5 Check [Move from：] and [Move to：], and then 
click [OK] to execute the move
Or click [Cancel] to cancel it

A dialog illustrating the progress of the move appears when 
the move starts.

Note：                                                                                
● Once it has been completed, a move cannot be undone.
● Do not exit this application during the move. Doing so can 

break the links between clips and their metadata. The link 
information for split clips can be lost, causing them to 
become abnormal clips. We recommend that you move 
important clips by copying them and then deleting the 

                                                                                                     
copy sources.

� To change the move destination
Click the [Move to：] box to highlight it, and then enter the 
name of the folder that you want to use as the move 
destination.

� To cancel the move operation
Click [Cancel] in the progress dialog.

� Reasons why a move operation may fail
Move operations may fail for the following reasons. In these 
cases, an error message appears and the move is not 
executed.

● There is not enough free capacity at the move destination 
folder.

● A clip with the same name as one of the copied clips 
already exists at the move destination. Even if the titles 
are different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the source or 
destination media or folders.

● The source or destination media or folder is write 
protected.
15



For Windows

Deleting Clips

Note：                                                                                 
● Clips with OK status can be deleted by this application. 

                                                                                                     
(A Page 8)

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), display the clips to delete

2 Select the clips to delete by clicking them

� To select multiple clips
Click the clips one after the other with the Ctrl key held down.

3 Do one of the following

● Press the Delete key.
● Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to delete 
the clips.

4 Click [OK] to execute the deletion
Or click [Cancel] to cancel it

Note：                                                                                 

                                                                                                     
● Deletions cannot be undone after they finish.

� Reasons why a delete operation may fail
Folder deletion operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not deleted.

● You do not have delete/write privileges to media or folder 
where the clips are stored.

● The media or folder where the clips are stored is write 
protected.

Grouping Split Clips
When you have split clips created as a result of an extended 
recording session, and those clips are saved on separate 
media, you can group those clips by collecting them in a 
single location. Grouped clips can be handled as a single 
clip.

� Procedures for grouping the split clips

1 Move or copy the media where the split clips 
are stored to folders with different names (Media1, 
Media2, Media3, etc.)

● Create each of the folders in the same root folder.

2 Combine Media2 and Media3 to the Media1 
folder according to the procedures for ACombining 
FoldersB (A Page 13)

3 The split clips are virtually combined in the 
Media1 folder, and displayed as a single thumbnail

Memo：                                                                                
For details on the operation, please refer to the following:

● [Copying Clips] (A Page 14)
● [Moving Clips] (A Page 15)
● [Combining Folders] (A Page 13)

Note：                                                                                
● Split clips which are not continuous along the time axis 

are not grouped.
● Unregistered clips and abnormal clips are not grouped.
● Grouping is performed on the basis of the UMIDs of split 

clips, and not on the basis of their file names. Clips with 

                                                                                                     
altered UMIDs are not grouped.

Clip Operations (continue)
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Importing Clips
This application does not recognize MP4 files that do not 
contain the necessary file information. You can import these 
MP4 files (unregistered clips) and register them as clips that 
can be handled by this application.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), select the media or folder 
that contains the MP4 files to be imported

2 Do one of the following to select the MP4 files 
to be imported

� Select unregistered clips (MP4 files) in the List View 
pane
● Select unregistered clips in the List View pane, and then 

select [Import] from the [File] menu.
● The Import dialog opens with the selected clips already 

entered in the import list.
● Proceed to step 6.

� Select unregistered clips in the Import dialog
● Select [Import] from the [File] menu.
● The [Import] dialog appears.
● Proceed to step 3.

3 Click the [...] button to open a folder browsing 
window and specify the MP4 file to import in that 
window

● The specified file appears in the [Import origin] edit box.

Note：                                                                                 

                                                                                                     
● Files over 4 GB in size cannot be imported.

4 Click the [Add] button to add the file to the list

5 Repeat steps 3 and 4 until you have selected all 
the files you want to import

� To delete a file from the list
● Select the file to delete and click [Delete].

6 Click [Start] to start the import

● Before you start importing, check to make sure that the 
import destination indicated in the dialog is correct.

● When the import finishes, the unregistered clips are 
converted to normal clips.

● An  mark is displayed for imported clips. (A Page 8)

� Reasons why an import operation may fail
File import operations may fail for the following reasons. In 
these cases, an error message appears and the files are not 
imported.

● You do not have delete/write privileges for the import 
destination media or folder.

● The import destination media or folder is write protected.

Memo：                                                                                
● What are unregistered clips?

The file format supported by this application contains files 
for managing the clip’s registration information. 
Unregistered clips are MP4 files that are not registered on 
this file. Clips cannot be registered manually via other 
means. Make sure that this is done using the import 
feature of this application.

● How to display the unregistered clips in the List View 
pane?
If a BPAV folder is found in the media or folder at the 
import destination, and MP4 files are located in the CLPR 
folder under the BPAV folder, a  mark appears beside 
the clip icon, and the clips can be displayed. If the clips 
are located in a folder other than CLPR, they cannot be 
listed.

Note：                                                                                
● The properties of import clips are set automatically.
● The timecode of import clips starts from 00:00:00:00.

                                                                                                     
● The import clips may not be playable on your device.
17



For Windows

Previewing Clips
You can preview clips in the Viewer window.

You can also display the clips on the computer in full-screen 
mode.

Memo：                                                                                 
● Several limitations apply to playback in the Viewer 

window. For details, please refer to AViewer WindowB 

                                                                                                     
(A Page 8).

� To display clips in the Viewer window
Display the clip that you want to preview in the List View 
pane of an Info window, and then double click it.

● Playback of the clip begins in the Viewer window.
● To stop the playback, click the Stop button.
● The timecode of the clip’s current position (or a counter 

value) and the duration of the clip (DUR) appear at the 
bottom of the screen.

� To control the preview
You can use the following methods to control playback and 
searches in the Viewer window.

● Use the APreview control buttonsB (A Page 8) in the 
Viewer window.

● Select [Play Control] from the [Viewer] menu, and then 
select the command you want to use.

● Drag the knob on the position bar.

� To select full-screen playback
● With a clip displayed in the View screen, double click the 

title bar of the Viewer window, or select [View]B[Full 
Screen] from the [Viewer] menu.

● To return the screen to its original size, double click on the 
screen or press the Esc key.

Changing the Index Picture of a Clip
You can change index pictures during clip previews.

1 Play a clip, and display the frame you want to 
use as the index picture

2 Click the Index Picture button, or select 
[Edit]B[Index Picture] from the [Viewer] menu

● The currently displayed frame becomes the clip’s index 
picture.

Note：                                                                                
● If you are previewing a clip that is stored on removable 

media, do not eject the media until the operation finishes.
● Do not power off the computer until the operation finishes.
● A frame near the specified frame may be displayed as the 

index picture on your device, instead of the specified 

                                                                                                     
frame itself.

Clip Operations (continue)
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Searching for Clips
If you cannot find the clip you want to play, you can search 
for it by title, comment or date of shooting.

1 Do one of the following

● In the Tree View pane of an Info window, select the media 
or folder where you think the clip is located.

● Open the [Change Root Folder] dialog by selecting 
[Change Root Folder] from the [View] menu, or by clicking 
the Change Root Folder button in the toolbar, and then 
select the media or folder where you think the clip is 
located.

A list of the clips in the selected media or folder appears in 
the List View pane.

2 Do one of the following

● Select [Search] from the [View] menu.
● Click the Search button in the toolbar.

The Search dialog appears. It appears with the path of the 
currently selected folder displayed in the [Search location] 
box.

3 Specify at least one of the following search 
conditions

● Enter all or part of a title in the [Title] box.
● Enter all or part of a comment in the [Description] box.
● Use the [DATE] buttons or list box to specify a range of 

dates.

4 Click [Search]

● A list of clips meeting the conditions specified in step 3 
appears in the Search dialog.

● Double click the clip you want to preview to display it in 
the Viewer window and start playback.

● A list of the clips stored in the same folder as the preview 
clip appears in the List View pane of an Info window.

Note：                                                                                
● Always observe the following precautions during a search.

● Do not delete a target folder.

                                                                                                     
● Do not eject the media before the operation completes.

Viewing Clip Properties
You can display a Properties window to view the properties 
of a clip.

Note：                                                                                
● Information in Info windows does not display properly if 

the selected font does not support the character code set 
used in the software operating environment. Before 
displaying information in the Info windows, select an 
appropriate font and character code set in the Options 
dialog.

● Carriage returns may be displayed for some fonts.
For details, please refer to AOption SettingsB 

                                                                                                     
(A Page 22).

� To display the Properties window

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 10), display the media or folder 
that contains the clip whose properties you want 
to check

2 Select the clip you want to check

3 Select [Properties] from the [Edit] menu

● The clip [Properties] appears.
19
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� Information displayed in the [Properties] window
The following table lists the information displayed in the Properties window. You can change the [Title1], [Title2], [Description] properties.

� To save changes to the displayed content
● Click [OK] to save the changes.
● Click [Cancel] to discard the changes.

Clip Operations (continue)

Item Description

Title1 (title) Displayed as the clip title in the List View pane. (Unless [Title2] has been set, in which 
case [Title2] is displayed.)
Title1 can consist of up to 63 alphanumeric characters and symbols (carriage returns not 
allowed).

Valid symbols: Space, –, +, #

Title2 (subtitle) Displayed as the clip title in the List View pane.

The information can be up to 127 bytes in length. (Multi-language titles are supported.)
Comments consisting of alphanumeric characters only can be up to 127 characters in 
length. UTF-8 encoding is used for multi-language comments. (The number of bytes 
required to encode UTF-8 characters varies. Normally it is between 1 and 3 bytes per 
character.)

Description (comment) A free comment about the clip. The comment can be up to 2047 bytes in length. (Multi-
language comments are supported.)

Comments consisting of alphanumeric characters only can be up to 2047 characters in 
length. UTF-8 encoding is used for multi-language comments. (The number of bytes 
required to encode UTF-8 characters varies. Normally it is between 1 and 3 bytes per 
character.)

Creator Information about the creator of the clip.

The information can be up to 127 bytes in length. (Multi-language titles are supported.)
Information consisting of alphanumeric characters only can be up to 127 characters in 
length. UTF-8 encoding is used for multi-language information.
(The number of bytes required to encode UTF-8 characters varies. Normally it is 
between 1 and 3 bytes per character.)

Status [OK] is displayed when the clip status is OK. Nothing is displayed when the status is 
anything else. (A Page 8)

Date (creation date) Date and time when the clip was created.

Last Update Date of the most recent modification to the clip.

This date is updated whenever the clip is copied, moved, or grouped, and when its title, 
description, or index picture is changed.

Recording Mode Operating mode of the device when it recorded the clip

Normal : Normal recording mode

Slow&QuickMotion : Slow & Quick Motion mode

Memo：                                                                                                                           

                                                                                                                                                  
● For details on each mode, please refer to the “INSTRUCTIONS” of your device.

Duration Duration of the clip in hours:minutes:seconds:frame format

Video Format Detailed information about the video format.

Audio Format Detailed information about the audio format.

Media Spanning (splitting the media) [Yes] appears for split clips, and [No] appears for clips which are not split.

Device Information about the recording device.
20



Recording Format and Recording Folders

� Recording format
This application software supports MP4 file format. This 
format has the following specifications.

● Folder names and the folder configuration are as shown in 
the following figure.

● Files contain link information pertaining to links between 
files and folders.

Note：                                                                                 
● Do not use applications other than the JVC ProHD Clip 

Manager to edit the files, delete, move, or rename the files 
and folders. Unless the format specifications are 
observed, files can become unreadable by ProHD series 

                                                                                                     
devices and by this application.

� Recording folders
The configuration of video and metadata folders is as shown 
in the following figure.
The data beneath the BPAV folder is handled as a single set 
of data.

Memo：                                                                                
● One BPAV folder exists when a work folder is opened in 

Explorer.
● To copy and backup your data, select the folders beneath 

the BPAV folder.
● When a work folder is selected in a Tree View pane of this 

application, a list of clips registered in the BPAV folder 
appears in the corresponding List View pane. AV data is 
saved in the folders beneath the CLPR folder.

● On the SxS memory card used by the recorder 
(KA-MR100G), the BPAV folder is created beneath the 
root folder of the media.

● On the SDHC memory card used by the recorder, the 
BPAV folder is created in the PRIVATE/JVC/ folder 
beneath the root folder of the media.

● MP4 files can be copied to beneath the CLPR folder. 
When this is done, they appear in a List View pane as 
unregistered MP4 clips when the BPAV folder to which 
the CLPR folder belongs is displayed in Thumbnails View 
or List View mode.

● The unregistered clips of MP4 files beneath the CLPR 
folder can be imported. When this is done, new folders 
are created beneath the CLPR folder, and the MP4 files 
are moved to those folders.

● The unregistered clips of MP4 files can also be imported 
from other folders. When this is done, new folders are 
created beneath the CLPR folder, and the imported clips 
are copied to those folders. Folder names are assigned 
automatically.

● Up to 600 clips can be saved in one recording folder.

Note：                                                                                
● Folder and file names are linked to metadata files. Do not 

                                                                                                     
change them.

Appendix

 

 

Media or work folder

BPAV

MEDIAPRO.XML

CUEUP.XML

CLPR

ABCD0001.MP4
(unregistered clips)

TAKR

MP4 clips, information files

MP4 clips, information files

MP4 clips, information files
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For Windows

Option Settings
The Options dialog allows you to configure the options of this 
application.

To open the Options dialog, select [Options]B[Manage] from 
the [Tool] menu.

Resolution Settings
Select [Options]B[Resolution] in the [Tool] menu to open the 
[Viewer Resolution] dialog that allows you to set the 
playback resolution.

� To change the playback resolution
Select the resolution from among [Normal Mode], [Half 
Mode] and [Quarter Mode].
Video quality is lower at [Half Mode] and [Quarter Mode], but 
playback response is better because these resolutions lower 
the burden on the decoder.

These resolutions are recommended if your computer is not 
powerful enough to deliver smooth playback at Normal 
resolution.

Appendix (continue)

Date Format For selecting the display format. YYYY 
represents the calendar year, MM the 
month, and DD the day.

You can also specify a delimiter 
character for use between years, 
months, and days by selecting it from 
the [Pause Character] list box. The date 
below the list box shows the current 
date formatted with the selected 
character.

Multi Language Click the [Font] button to open a font 
selection dialog, which selects the 
display font and character code set for 
titles and comments.

Display 
Language

Selects AEnglishB or AJapaneseB as the 
display font for this application.
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Shortcut Key List
This application supports keyboard shortcuts for many operations. The following tables show keyboard shortcuts by menu. In the 
Operation column, the notation “Ctrl + R” indicates operations in which one key (in this case the Ctrl key) is held down while 
pressing another key (in this case the R key).

� File menu

� Edit menu

Command Operation Function Reference

Rename Ctrl + R Rename the selected folder. A Page 12

Create New 
Folder

Ctrl + N Create a new folder in the selected media or folder. A Page 11

Open Containing 
Folder

Ctrl + E Start Explorer and open the currently selected folder. A Page 12

Import Ctrl + M Import MP4 file (unregistered clip). A Page 17

Command Operation Function Reference

Copy All Ctrl + Shift + C Copy all of the clips in the current media or folder. A Page 13

Cut Ctrl + X Cut the selected clip. A Page 15

Copy Ctrl + C Copy the selected clip. A Page 14

Paste Ctrl + V Paste a cut or copied clip. A Page 14
A Page 15

Delete Delete Delete the selected clip. A Page 16

Properties Ctrl + I Open the Properties window of the selected clip. A Page 19

Split Ctrl + W Split the selected folder into smaller folders of a specified size. A Page 12

Combine Ctrl + J Combine specified folders into another folder. A Page 13
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For Windows

� View menu

� Viewer menu

� Tools menu

Appendix (continue)

Command Operation Function Reference

Tree View Shift + T Display or hide the Tree View pane. —

Change Root Folder Shift + O Change the root folder of the Tree View pane. A Page 10

Up Shift + U Moves up to the next folder. A Page 10

Thumbnails Shift + H Put the List View pane into Thumbnails View mode. A Page 7

List Shift + L Put the List View pane into List View mode.

Details Shift + D Put the List View pane into Details View mode.

Sort By>Title Ctrl + Shift + N Sort the clips in the List View pane in ascending or descending 
order by title.

Sort By>Size Ctrl + Shift + S Sort the clips in the List View pane in ascending or descending 
order by size.

Sort By>Duration Ctrl + Shift + D Sort the clips in the List View pane in ascending or descending 
order by duration.

Sort By>Date Ctrl + Shift + P Sort the clips in the List View pane in ascending or descending 
order by date and time.

Search F3 Search for a clip. A Page 19

Refresh F5 Update the data displayed in the Tree View pane and List View 
pane with the latest data.

—

Command Operation Function Reference

Play Control>Play 5 or L Start play. A Page 8

Play Control>Stop Space or K Stop at the current position.

Play Control>Fast 
Forward

S Search in the forward direction (fast forward).

Play Control>Rewind A Search in the reverse direction (rewind).

Play Control>Jump 
To Head

Q Move to the first frame of the clip.

Play Control>Jump 
To End

W Move to the last frame of the clip.

Play Control>Next 
Frame

4 Step 1 frame forward.

Play 
Control>Previous 
Frame

3 Step 1 frame back.

View>Full Screen F11 Display in full-screen mode. A Page 18

Command Operation Function Reference

Options>Manage Ctrl + O Open the Options dialog of this application. A Page 22

Options>Resolution Ctrl + P Set the playback resolution. A Page 22
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This product uses software subject to the GNU Lesser 
General Public License (LGPL).

Library name: FFMPEG

FFmpeg is a trademark of Fabrice Bellard, originator of the 
FFmpeg project.

Thank you for your purchase of this product.

This product uses the following software, which is subject 
to the LGPL. You have the right to obtain, modify and 
distribute the source code to this software.

FFMPEG

● avcodec-51.dll
● avformat-51.dll
● avutil-49.dll

The source code is contained in the /Software/
ClipManager/SRC folder of the bundled CD-ROM.

It may also be downloaded from the following web site.

http://www.jvc-victor.co.jp/download/lnx/06jvc_pro/
jvc_pro_linux_download_page.html

Please note that we cannot respond to inquiries regarding 
the content of the source code.
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For MAC OS

Install this application on a computer meeting the following 
hardware and software requirements.

Installing from the CD-ROM

1 Insert the bundled CD-ROM into the CD-ROM 
drive of your computer

2 Double clicked the disc icon

● Finder starts, and the contents of the CD-ROM appear.

3 Double click [JVC ProHD Clip Manager.dmg] in 
the [Software]B[ClipManager]B[MAC OS X] folder

● The installation screen appears. Follow the on-screen 
instructions to complete the installation.

● The End-User License Agreement screen will appear, 
click [Agree] to proceed with the installation.

To Uninstall the Application
Move the installation destination folder of the application 
(default: /Application/JVC ProHD Clip Manager) to the Trash.

Launching the Application
Use Finder to open the [JVC ProHD Clip Manager] folder in 
the [Applications] folder, and double click [JVC ProHD Clip 
Manager].

The application starts, and the operating windows 
(A Page 27) appear.

Exiting the Application
Do one of the following:

● Select [Quit JVC ProHD Clip Manager] from the JVC 
ProHD Clip Manager menu.

● Click the [ × ] (close) button in the upper left of the 
operating window.

Note：                                                                                
● Do not power off the computer while a file operation is still 

underway. Files may be corrupted. Wait until the 
operating finishes, or cancel the operation, before 

                                                                                                     
powering off.

Operating Environment

Item Requirement

Processor Intel Core 2 Duo 2 GHz or higher 
recommended

Memory 2 GB or more recommended

OS Mac OS X 10.5.5 or higher

Installing the Application

Launching and Exiting the 
Application
26



Operating Window Configuration
The following figure shows the default configuration of the operating windows.
Descriptions of this manual are based on screens with English display settings.

Name and Function of 
Parts

Viewer window (A Page 29)

Info windows (A Page 28)
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For MAC OS

Info Windows
These windows display the clips in the media and folders. 
You can view, copy or delete the clips. The configuration of 
Info window is as follows:

A Tool buttons
Contains tool buttons for operations on clips and folders.

B Tree View pane
Displays two levels of the tree structure of removal media or 
folders in the hard disk drive. A folder in the lower level can 
be double clicked to make it the root folder and display the 
level beneath that folder. When you click a media item or 
double click a folder, the clips in the media or folder appear 
in the List View pane.

C List View pane
Displays the clips in the media or folder that is selected in the 
Tree View pane.

A mark indicating the status of the clip is display on the 
thumbnail shown as follows.

T1 : Clips with OK status can be moved or deleted by this 
application.

T2 : A video that exceeds 4 GB will automatically be 
saved as multiple clips. These clips are parts of the 
complete recording and can be saved on multiple 
media. All of the original recorded video is not played 
back when a split clip is played back.

T3 : A clip that cannot be played or displayed properly by 
this application. The file may be corrupted, file links 
may be broken or changed, required files may be 
missing, or thumbnail creation may have failed.

T4 : When another application is using the clip file.

D Used capacity
Displays the capacity used by clips and their related 
metadata in the currently selected media or folder.

Name and Function of 
Parts (continue)

Tool buttons
Function Reference

Icon Name

Create 
New 
Folder

Creates a new 
folder in the 
currently selected 
location.

A Page 31

Search Opens the clip 
search screen, 
and allows you to 
search a clip by 
title or date.

A Page 40

Up Moves up to the 
next folder.

^

Change 
Root 
Folder

Changes the root 
folder in the Tree 
View pane.

^

Split Splits a folder 
according to the 
size selected.

A Page 33

Copy All Copy all of the 
clips in the current 
media or folder.

A Page 34

A

B

C

D

View mode Icon Description

Thumbnails 
view

Normal clip

Clip with OK status (as 
set on the recorder) T1

One of the smaller 
clips into which a 
longer recording has 
been split (a frame is 
displayed around it) T2

 Imported MP4 clip

Unregistered MP4 clip 
(clip that has not been 
imported)

Abnormal clip T3 T4
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Viewer Window
This window is where you preview clips. You can use the 
preview control buttons to playback, fast forward or fast 
rewind.

A Screen
Displays the playback video.

B Timecode
Displays the timecode of the position bar and the duration of 
the clip.

● The counter operates at 25 fps for unregistered clips.
● The count for import clips starts at 00:00:00:00.

C Position bar
Displays the current position in the clip. You can move to any 
position in the clip by dragging the knob or by clicking directly 
on the position bar.

D Preview control buttons
These are buttons for controlling clip previews. The buttons 
(starting from the leftmost button on the screen) and their 
functions are as follows:

Fast Rewind button
:  Search back from the current position 

(rewind).
Single Frame Reverse button

:  Step back 1 frame.
Stop button :  Stop at the current position.
Play button :  Start play.
Single Frame Forward button

:  Step forward 1 frame.
Fast Forward button

:  Search forward from the current position (fast 
forward).

Move to First Frame button
: Go to the first frame of the clip.

Move to Last Frame button
: Go to the last frame of the clip.

E [Audio Channel] (Audio channel) selection 
buttons

Click the [Stereo]/[Monaural] button to switch between the 
Stereo and Monaural modes. When [Stereo] is displayed, 
audio is output from both channels. When [Monaural] is 
displayed, audio can be output by selecting CH1 or CH2.

F [Index Picture] button
Sets the index picture of the current preview clip to a still 
image of the currently displayed frame. However, setting 
performed using this button will not be applied to the 
thumbnail display on the device.

Note：                                                                                
● Playback in this window is preview playback. Note the 

following points:
● Depending on the performance of your computer and 

the processing load, dropped frames may occur and 
timecode may differ from the actual values.

● When the playback clip is defective, video breakup 
may occur and the playback may freeze.

● All of the original recorded video is not played back 
when a split clip is played back.

● It may not be possible to play clips created on devices 
other than the device you are using.

● If the colors of the playback video are not normal, exit 
the software and try adjusting the color parameters in 
the Properties window of your desktop screen. It may 
be possible to restore normal colors.

● Improper playback may occur if the screen properties 
of your computer are changed during playback. If this 
occurs, restart the application.

● The video may not appear on both monitors when you 
try to display it on the computer’s monitor and an 
external monitor, for example when using a laptop 

                                                                                                     
computer.

A

B

C

D

E

F
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This section describes the procedures for operating clips that 
are recorded in the MP4 file format, which is supported by 
this software.

Note：                                                                                 
● Make sure that operations such as copying and deletion 

of clips are performed using this application. The recorded 
video/audio clips (MP4 files) come with other information 
files. Operating the clips via other means may therefore 

                                                                                                     
cause problems that prevent proper file management.

The basic procedures for operating the clips are as follows:

K

K

This section explains how to select the media or folder that 
contains the clips you want to work with.

There are two ways to select them, by using the Tree View 
pane of an Info window, or by using the Change Root Folder 
dialog.

Memo：                                                                                
● In this manual, “media” refers to the following media 

types:
● SxS memory card
● USB memory
● SDHC memory card
● Internal hard disk
● Externally connected hard disk
● CD-R
● DVD-R

                                                                                                     
● Blu-ray Disc

To Select in the Tree View Pane

1 In the Tree View pane of an Info window, double 
click the media or folder that you want to select

● The level beneath the double clicked media or folder 
appears. The Tree View pane displays two levels, 
consisting of the media or folder itself and the next lower 
level.

● When there are clips saved directly to the top level of the 
media, they appear in the List View pane.

2 Double click a lower-level folder

● The double clicked folder becomes the root folder, and its 
lower level folders appear.

� To return to the next higher level
Select [Up] from the [View] menu, or click the Up button in 
the toolbar.

3 Repeat step 2 as required

● The contents of the selected folder appear in the List View 
pane.

Procedures for Operating 
Clips Using Clip Manager

Step 1

Selecting Work Media and Work 
Folders (A Page 30)
Select the media or folder in which the clips 
are stored, and display the corresponding Info 
window.

Step 2

Folder and Media Operations 
(A Page 31)
Select the folder to be manipulated, such as 
the folder to copy files to, or create a new 
folder.
All clips inside a media/folder can be copied or 
backed up.

Step 3

Clip Operations (A Page 35)
Make use of the toolbar buttons and other 
buttons to perform the necessary operations, 
such as copying, moving, or deleting clips 
stored in a media/folder.

Selecting Work Media and 
Work Folders
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To select in the Change Root Folder 
Dialog

1 Select [Change Root Folder] from the [View] 
menu, or click the Change Root Folder button

2 In the Tree View pane of the dialog, select a 
media item or folder

3 Click [OK]

● The Change Root Folder dialog closes, and the contents 
of the selected media or folder appear in the List View 
pane.

Note：                                                                                 
● When you select a media item, a message may appear 

saying that AThe work folder or media needs to be 
repaired.B, and that ARestore on the recording deviceB. 
This message appears when the data is defective, 
typically because the recording device was powered off 
during recording, or because the media was ejected too 
soon. If this message appears, you should reinsert the 
media into the recording device and attempt to salvage it 
as soon as possible. The data may become 
unrecoverable if you continue to work with it without 

                                                                                                     
salvaging it.

Note：                                                                                
● Always observe the following precautions during 

processing of folder and media operations.
● Do not power off the computer or media drive before 

the operation completes.

                                                                                                     
● Do not eject the media before the operation completes.

Clip Folders for MP4 File Format
The clips are stored together with a BPAV folder 
(A Page 42). (This folder does not appear in the Info 
windows, but it can be seen in Finder.)
Whenever you copy or move clips with this application, copy 
or move the BPAV folder along with the clips. You cannot 
work with clips separately from the BPAV folder.

Note：                                                                                
● Simultaneous access to files may not be possible when 

you attempt to access the same folder at the same time 

                                                                                                     
from several computers over a network connection.

Creating Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the media or open the 
folder where you want to create the folder, making 
it the root folder of the Tree View pane

2 With the root folder having the focus, select 
[Create New Folder] from the [File] menu, or click 
the [Create New Folder] button

● A new folder is created on the selected media or in the 
selected folder in step 1.

� Reasons why folder creation may fail
Folder creation operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not created.

● You do not have write privileges for the media or folder 
selected in step 1.

● The media or folder selected in step 1 is write protected.

Folder and Media 
Operations
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Note：                                                                                 
● A new folder for storing files cannot be created in a folder 

where clips are already stored. Create a folder at a 
location that is at least two levels higher.
Example: With the Archive folder as the root work folder, 

new folders can be created at the higher level 
for each media or administrative classification 
(Media1, Media2, etc.).

● Folders cannot be created when this is not allowed by the 
computer file system.

● Immediately after they are created, new folders are 
normal folders. But when even one clip is copied or 
moved to the new folder, the folder is formatted as an 
work folder with the same format as the device in use. 
(The required subfolders and metadata files are created 
automatically.)

● The name ABPAVB is reserved and cannot be specified.
● Characters forbidden by the operating system cannot be 

                                                                                                     
used in folder names.

� To rename a folder

1 Select the newly created folder, and then select 
[Rename] from the [File] menu

● The [Rename] dialog appears.

2 Enter the new name in the edit box (up to 80 
alphanumeric characters and symbols)

● The name ABPAVB is reserved and cannot be specified.
● Characters forbidden by the operating system cannot be 

used in folder names.

3 Click [OK]

� To back up folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the folder that you 
want to back up

2 Select [Open Containing Folder] from the [File] 
menu

● Finder appears.

3 Perform your backup operations in Finder

When a folder is too large to save to your backup media
You can split the folder into smaller folders, which can be 
saved on separate discs. Split folders can later be combined 
to restore the original large folder.

Memo：                                                                                
● For details, refer to ASplitting FoldersB (A Page 33) and 

                                                                                                     
ACombining FoldersB (A Page 34).

Folder and Media 
Operations (continue)
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Deleting Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the folder to delete

2 Press the delete key with the Command key 
held down, or select [Delete] from the [Edit] menu

� Reasons why a folder deletion may fail
Folder deletion operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not deleted.

● You do not have delete/write privileges for the selected 
folder.

● The selected folder is write protected.
● Clips or other folders exist beneath the folder. T1

Note：                                                                                 
● Be careful when deleting folders, because all data in the 

folder is deleted.

                                                                                                     
● Deletions cannot be undone after they finish.

T1 : The following shows two situations in which a folder 
cannot be deleted.
● When there is a file that is not linked to the object 

folder
● When there is another folder besides the object 

folder
In these cases, the file which is not linked to the 
object folder and any other folder must be deleted 
beforehand.

Splitting Folders
You can split large folders into smaller folders. This allows 
you to back up all of the clips in a large folder to media that is 
not large enough to save the entire folder without splitting.
For example, you can split an 8 GB folder into two 4 GB 
folders in order to save them on 4 GB DVD-R media. Note 
that individual files in the large folder are not split.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the folder to split

2 Select [Split Folder] in the [Edit] menu, or click 
the Split Folder button

● The [Split Folder] dialog appears.

Note：                                                                                
● Note that individual files in the large folder are not split. 

Clips are assigned to the split folders in such a way that 
the split folders have the specified size. This means that it 
is not possible to specify a split folder size smaller than 
the largest file in the original folder.

● It is also not possible to specify a split folder size smaller 

                                                                                                     
than 4 GB.

3 Select the size of the split folders from the 
drop-down list

4 Click [Start]

● You can select from 4 GB to 60 GB in increments of 4 GB.
● The folder is split into the minimum number of folders that 

will produce the specified folder size, and clips are 
assigned to the smaller folders. The folders produced as a 
result of the split have the same name as the original 
folder, followed by serial numbers.

Note：                                                                                
● Once it starts, a split operation cannot be canceled before 

it finishes.
● Split clips may be assigned to different folders. If you 

would prefer that split clips be assigned to other folders, 

                                                                                                     
you can move them manually after the folder split.
33



For MAC OS

Combining Folders
You can combine specified folders into another folder. This 
allows you to restore the original folder from split folders.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the destination folder 
into which the other folders will be combined

2 Select [Combine Folder] from the [Edit] menu

● The [Combine Folder] dialog appears.

3 Check the check boxes of the folders that you 
want to combine into the folder selected in step 1
Check the [Delete the folder(s) after folder 
combination.] check box if you want to delete the 
combined folders after the combine

Note：                                                                                 
● The combined folders are not deleted when:

● They contain other folders.
● You do not have delete/write privileges to the original folders.

                                                                                                     
● The folders are write protected.

4 Click [Start]
● The folders selected in step 3 are combined into the 

destination folder specified in step 1. The clips in all of the 
folders are gathered into the destination folder.

● If any of the clips are split clips, they are automatically 
grouped, allowing them to be handled as a single clip.

� Reasons why a folder combine operation may fail
Folder combine operations may fail for the following reasons. 
In these cases, an error message appears and the combine 
is not executed.

● There is not enough free capacity in the combine 
destination folder.

● You do not have write privileges to the source or 
destination folders.

● The source or destination folder is write protected.
● Multiple instances of the same clip exist.

Copying All the Clips in Media or Folders

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select a copy source media 
or folder in one of the Info windows

2 In the other Info window, select a copy 
destination media or folder

3 Activate the copy source Info window, and 
select [Copy All] from the [Edit] menu or click the 
Copy All button

● The [Copy All] dialog appears.

4 Check [Copy to] and [Copy from：], and then 
click [OK] to execute the copy
Or click [Cancel] to cancel it

� To change the copy destination
Click the [Copy from：] box to highlight it, and enter a folder 
name as the new copy destination.

● When the copying starts, a progress dialog appears to 
display the status of the copy task.

� To cancel the copy
Click [Cancel] in the progress dialog.

� Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In these 
cases, an error message appears and the copy is not 
executed.

● There is not enough free capacity at the copy destination.
● A clip with the same name as one of the copied clips 

already exists at the copy destination. Even if the titles are 
different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the source or 
destination media or folders.

Folder and Media 
Operations (continue)
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Note：                                                                                 
● Always observe the following precautions during 
processing of clip operations.

● Do not power off the computer or media drive before 
the operation completes.

● Do not use Finder or other file management tool to 
delete folders that contain the clips being processed.

● Do not eject the media before the operation completes.
● Locked files and folders cannot be moved, modified, or 

                                                                                                     
deleted.

Copying Clips
You can duplicate clips on your media or computer, and copy 
clips between the media and the computer.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), display the clips that you 
want to copy in one of the Info windows

2 In the other Info window, select a copy 
destination media or folder

� If you want to copy the clips to a new folder
● Create a new folder in the copy destination media or 

folder.

Memo：                                                                                 
● For details on how to create folders, please refer to 

                                                                                                     
ACreating FoldersB (A Page 31).

3 Select the clips to copy in the copy source 
window

� To select multiple clips
● Click the clips one after the other with the shift key held 

down.

Memo：                                                                                 
● Unregistered clips and abnormal clips can be selected, 

                                                                                                     
but they are not copied.

4 Do one of the following

● Drag the selected clips and drop them in the List View 
pane of the Info window of the copy destination media or 
folder.

● Select [Copy] from the [Edit] menu. Then click the Info 
window of the copy destination media or folder and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the copy.

5 Check [Copy to] and [Copy from：], and then 
click [OK] to execute the copy
Or click [Cancel] to cancel it

When the copying starts, a progress dialog appears to 
display the status of the copy task.

Note：                                                                                

                                                                                                     
● Once it has been completed, a copy cannot be undone.

� To change the copy destination
Click the [Copy from：] box to highlight it, and enter a folder 
name as the new copy destination.

� To cancel the copy
Click [Cancel] in the progress dialog.

� Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In these 
cases, an error message appears and the copy is not 
executed.

● There is not enough free capacity at the copy destination.
● A clip with the same name as one of the copied clips 

already exists at the copy destination. Even if the titles are 
different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the copy 
destination media or folders.

● The copy destination media or folder is write protected.

Clip Operations
35



For MAC OS

Moving Clips
You can move clips on your media or computer, and move 
clips between the media and the computer.

Note：                                                                                 

                                                                                                     
● Clips with OK status can be moved by this application.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), display the clips that you 
want to move in one of the Info windows

2 In the other Info window, select a move 
destination media or folder

� If you want to move the clips to a new folder
Create a new folder in the move destination media or folder.

Memo：                                                                                 
● For details on how to create folders, please refer to 

                                                                                                     
ACreating FoldersB (A Page 31).

3 Select the clips to move in the move source 
window

� To select multiple clips
Click the clips one after the other with the shift key held 
down.

Note：                                                                                 
● Unregistered clips and abnormal clips can be selected, 

                                                                                                     
but they are not moved.

4 Do one of the following

● Drag the selected clips with the Ctrl key held down and 
drop them in the List View pane of the Info window of the 
move destination media or folder.

● Select [Cut] from the [Edit] menu. Then click the Info 
window of the move destination media or folder and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the move.

5 Check [Move from：] and [Move to：], and then 
click [OK] to execute the move
Or click [Cancel] to cancel it

Note：                                                                                
● Once it has been completed, a move cannot be undone.
● Do not exit this application during the move. Doing so can 

break the links between clips and their metadata. The link 
information for split clips can be lost, causing them to 
become abnormal clips. We recommend that you move 
important clips by copying them and then deleting the 

                                                                                                     
copy sources.

� To change the move destination
● Click the [Move to：] box to highlight it, and then enter the 

name of the folder that you want to use as the move 
destination.

● A dialog illustrating the progress of the move appears 
when the move starts.

� To cancel the move operation
Click [Cancel] in the progress dialog.

� Reasons why a move operation may fail
Move operations may fail for the following reasons. In these 
cases, an error message appears and the move is not 
executed.

● There is not enough free capacity at the move destination 
folder.

● A clip with the same name as one of the copied clips 
already exists at the move destination. Even if the titles 
are different, clips are recognized as the same clip if they 
share they same ID (UMID).

● You do not have delete/write privileges to the source or 
destination media or folders.

● The source or destination media or folder is write 
protected.

Clip Operations (continue)
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Deleting Clips

Note：                                                                                 

                                                                                                     
● Clips with OK status can be deleted by this application.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), display the clips to delete

2 Select the clips to delete by clicking them

� To select multiple clips
● Click the clips one after the other with the shift key held 

down.

3 Do one of the following

● Press the delete key with the Command key held down.
● Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to delete 
the clips.

4 Click [OK] to execute the deletion
Or click [Cancel] to cancel it

Note：                                                                                 

                                                                                                     
● Deletions cannot be undone after they finish.

� Reasons why a delete operation may fail
Folder deletion operations may fail for the following reasons. 
In these cases, an error message appears and the folder is 
not deleted.

● You do not have delete/write privileges to media or folder 
where the clips are stored.

● The media or folder where the clips are stored is write 
protected.

Grouping Split Clips
When you have split clips created as a result of an extended 
recording session, and those clips are saved on separate 
media, you can group those clips by collecting them in a 
single location. Grouped clips can be handled as a single 
clip.

� Procedures for grouping the split clips

1 Move or copy the media where the split clips 
are stored to folders with different names (Media1, 
Media2, Media3, etc.)

● Create each of the folders in the same root folder.

2 Combine Media2 and Media3 to the Media1 
folder according to the procedures for ACombining 
FoldersB (A Page 34)

3 The split clips are virtually combined in the 
Media1 folder, and displayed as a single thumbnail

Memo：                                                                                
For details on the operation, please refer to the following:

● ACopying ClipsB (A Page 35)
● AMoving ClipsB (A Page 36)
● ACombining FoldersB (A Page 34)

Note：                                                                                
● Split clips which are not continuous along the time axis 

are not grouped.
● Unregistered clips and abnormal clips are not grouped.
● Grouping is performed on the basis of the UMIDs of split 

clips, and not on the basis of their file names. Clips with 

                                                                                                     
altered UMIDs are not grouped.
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Importing Clips
This application does not recognize MP4 files that do not 
contain the necessary file information. You can import these 
MP4 files (unregistered clips) and register them as clips that 
can be handled by this application.

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), select the media or folder 
that contains the MP4 files to be imported

2 Do one of the following to select the MP4 files 
to be imported

� Select unregistered clips (MP4 files) in the List View 
pane
● Select unregistered clips in the List View pane, and then 

select [Import] from the [File] menu.
● The Import dialog opens with the selected clips already 

entered in the import list.
● Proceed to step 6.

� Select unregistered clips in the Import dialog
● Select [Import] from the [File] menu.
● The Import dialog appears.
● Proceed to step 3.

3 Click the [...] button to open a folder browsing 
window and specify the MP4 file to import in that 
window

● The specified file appears in the [Import origin] edit box.

Note：                                                                                 

                                                                                                     
● Files over 4 GB in size cannot be imported.

4 Click the [Add] button to add the file to the list

5 Repeat steps 3 and 4 until you have selected all 
the files you want to import

� To delete a file from the list
Select the file to delete and click [Delete].

6 Click [shift] to start the import

● Before you start importing, check to make sure that the 
import destination indicated in the dialog is correct.

● When the import finishes, the unregistered clips are 
converted to normal clips.

● An  mark is displayed for imported clips. (A Page 28)

� Reasons why an import operation may fail
File import operations may fail for the following reasons. In 
these cases, an error message appears and the files are not 
imported.

● You do not have delete/write privileges for the import 
destination media or folder.

● The import destination media or folder is write protected.

Memo：                                                                                
● What are unregistered clips?

The file format supported by this application contains files 
for managing the clip’s registration information. 
Unregistered clips are MP4 files that are not registered on 
this file. Clips cannot be registered manually via other 
means. Make sure that this is done using the import 
feature of this application.

● How to display the unregistered clips in the List View 
pane?
If a BPAV folder is found in the media or folder at the 
import destination, and MP4 files are located in the CLPR 
folder under the BPAV folder, a  mark appears beside 
the clip icon, and the clips can be displayed. If the clips 
are located in a folder other than CLPR, they cannot be 
listed.

Note：                                                                                
● The properties of import clips are set automatically.
● The timecode of import clips starts from 00:00:00:00.

                                                                                                     
● The import clips may not be playable on your device.

Clip Operations (continue)
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Previewing Clips
You can preview clips in the Viewer window.
You can also display the clips on the computer in full-screen 
mode.

Memo：                                                                                 
● Several limitations apply to playback in the Viewer 

window. For details, please refer to AViewer WindowB 

                                                                                                     
(A Page 29).

� To display clips in the Viewer window
Display the clip that you want to preview in the List View 
pane of an Info window, and then double click it.

● Playback of the clip begins in the Viewer window.
● To stop the playback, click the Stop button.
● The timecode of the clip’s current position (or a counter 

value) and the duration of the clip (DUR) appear at the 
bottom of the screen.

� To control the preview
You can use the following methods to control playback and 
searches in the Viewer window.
● Use the preview control buttons (A Page 27) in the 

Viewer window.
● Select [Play Control] from the [Viewer] menu, and then 

select the command you want to use.
● Drag the knob on the position bar.

� To select full-screen playback
● With a clip displayed in the View screen, select 

[View]B[Full Screen] from the [Viewer] menu.
● To return the screen to its original size, double click on the 

screen or press the Esc key.

Changing the Index Picture of a Clip
You can change index pictures during clip previews.

1 Play a clip, and display the frame you want to 
use as the index picture

2 Click the [Index Picture] button, or select 
[Edit]B[Index Picture] from the [Viewer] menu

● The currently displayed frame becomes the clip’s index 
picture.

Note：                                                                                
● If you are previewing a clip that is stored on removable 

media, do not eject the media until the operation finishes.
● Do not power the computer off until the operation finishes.
● On the recorder or camcorder, a frame near the specified 

frame may be displayed as the index picture, instead of 

                                                                                                     
the specified frame itself.
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Searching for Clips
If you cannot find the clip you want to play, you can search 
for it by title, comment or date of shooting.

1 Do one of the following

● In the Tree View pane of an Info window, select the media 
or folder where you think the clip is located.

● Open the Change Root Folder dialog by selecting 
[Change Root Folder] from the [View] menu, or by clicking 
the Change Root Folder button, and then select the media 
or folder where you think the clip is located.

A list of the clips in the selected media or folder appears in 
the List View pane.

2 Do one of the following

● Select [Search] from the [View] menu.
● Click the Search button ( ).

The Search dialog appears. It appears with the path of the 
currently selected folder displayed in the [Search location] 
box.

3 Specify at least one of the following search 
conditions

● Enter all or part of a title in the [Title] box.
● Enter all or part of a comment in the [Description] box.
● Use the [DATE] buttons or list box to specify a range of 

dates.

4 Click [Search]

● A list of clips meeting the conditions specified in step 3 
appears in the Search dialog.

● Double click the clip you want to preview to display it in 
the Viewer window and start playback.

● And a list of the clips stored in the same folder as the 
preview clip appears in the List View pane of an Info 
window.

Note：                                                                                
● Always observe the following precautions during a search.

● Do not delete a target folder.

                                                                                                     
● Do not eject the media before the operation completes.

Viewing Clip Properties
You can display a Properties window to view the properties 
of a clip.

Note：                                                                                
● Information in Info windows does not display properly if 

the selected font does not support the character code set 
used in the software operating environment. Select an 
appropriate font before displaying information in the 

                                                                                                     
Properties window.

� To display the Properties window

1 Referring to ASelecting Work Media and Work 
FoldersB (A Page 30), display the media or folder 
that contains the clip whose properties you want 
to check

2 Select the clip you want to check

3 Select [Properties] from the [Edit] menu

● The clip [Properties] appears.

Clip Operations (continue)
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Viewing Clip Properties (continue)
� Information displayed in the [Properties] window
The following table lists the information displayed in the Properties window. You can change the [Title1], [Title2], [Description] 
properties.

� To save changes to the displayed content
● Click [OK] to save the changes.
● Click [Cancel] to discard the changes.

Item Description
Title1 (title) Displayed as the clip title in the List View pane. (Unless [Title2] has been set, in 

which case [Title2] is displayed.)
Title1 can consist of up to 63 alphanumeric characters and symbols (carriage 
returns not allowed).
Valid symbols: Space, –, +, #

Title2 (subtitle) Displayed as the clip title in the List View pane.
The information can be up to 127 bytes in length. (Multi-language titles are 
supported.)
Information consisting of alphanumeric characters only can be up to 127 
characters in length. UTF-8 encoding is used for multi-language information.
(The number of bytes required to encode UTF-8 characters varies. Normally it is 
between 1 and 3 bytes per character.)

Description (comment) A free comment about the clip. The comment can be up to 2047 bytes in length.
(Multi-language comments are supported.)
Information consisting of alphanumeric characters only can be up to 2047 
characters in length. UTF-8 encoding is used for multi-language information.
(The number of bytes required to encode UTF-8 characters varies. Normally it is 
between 1 and 3 bytes per character.)

Creator Information about the creator of the clip.
The information can be up to 127 bytes in length. (Multi-language comments are 
supported.)
Information consisting of alphanumeric characters only can be up to 127 
characters in length. UTF-8 encoding is used for multi-language information.
(The number of bytes required to encode UTF-8 characters varies. Normally it is 
between 1 and 3 bytes per character.)

Status [OK] is displayed when the clip status is OK. Nothing is displayed when the 
status is anything else. (A Page 28)

Date (creation date) Date and time when the clip was created.
Last Update Date of the most recent modification to the clip.

This date is updated whenever the clip is copied, moved, or grouped, and when 
its title, description, or index picture is changed.

Recording Mode Operating mode of the device when it recorded the clip.

Normal : Normal recording mode
Slow&QuickMotion : Slow & Quick Motion mode

Memo：                                                                                                                
● For details on each mode, please refer to the “INSTRUCTIONS” of your 

                                                                                                                                      
device.

Duration Duration of the clip in hours:minutes:seconds:frame format.

Video Format Detailed information about the video format.
Audio Format Detailed information about the audio format.

Media Spanning (splitting the media) [Yes] appears for split clips, and [No] appears for clips which are not split.

Device Information about the recording device.
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Recording Format and Recording Folders

� Recording format
This application software supports MP4 file format. This 
format has the following specifications. This format has the 
following specifications.

● Folder names and the folder configuration are as shown in 
the following figure.

● Files contain link information pertaining to links between 
files and folders.

Note：                                                                                 
● Do not use applications other than the JVC ProHD Clip 

Manager to edit the files, delete, move, or rename the files 
and folders. Unless the format specifications are 
observed, files can become unreadable by ProHD series 

                                                                                                     
devices and by this application.

� Recording folders
The configuration of video and metadata folders is as shown 
in the following figure.
The data beneath the BPAV folder is handled as a single set 
of data.

Memo：                                                                                
● One BPAV folder exists when a work folder is opened in 

Finder.
● To copy and backup your data, select the folders beneath 

the BPAV folder.
● When a work folder is selected in a Tree View pane of this 

application, a list of clips registered in the BPAV folder 
appears in the corresponding List View pane. AV data is 
saved in the folders beneath the CLPR folder.

● On the SxS memory card used by the recorder 
(KA-MR100G), the BPAV folder is created beneath the 
root folder of the media.

● On the SDHC memory card used by the recorder, the 
BPAV folder is created in the PRIVATE/JVC/ folder 
beneath the root folder of the media.

● MP4 files can be copied to beneath the CLPR folder. 
When this is done, they appear in a List View pane as 
unregistered MP4 clips when the BPAV folder to which 
the CLPR folder belongs is displayed in Thumbnails View 
or List View mode.

● The unregistered clips of MP4 files beneath the CLPR 
folder can be imported. When this is done, new folders 
are created beneath the CLPR folder, and the MP4 files 
are moved to those folders.

● The unregistered clips of MP4 files can also be imported 
from other folders. When this is done, new folders are 
created beneath the CLPR folder, and the imported clips 
are copied to those folders. Folder names are assigned 
automatically.

● Up to 600 clips can be saved in one recording folder.

Note：                                                                                
● Folder and file names are linked to metadata files. Do not 

                                                                                                     
change them.

Appendix

 

 

Media or work folder

BPAV

MEDIAPRO.XML

CUEUP.XML

CLPR

ABCD0001.MP4
(unregistered clips)

TAKR

MP4 clips, information files

MP4 clips, information files

MP4 clips, information files
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Option Settings
The [Manage] dialog allows you to configure the options of 
this application.
To open the [Manage] dialog, select [Manage] from the 
[XDCAM EX Clip Browser] menu.

Note：                                                                                 
● On the Macintosh, language switching is handled by the 

                                                                                                     
operating system.

Date Format For selecting the display format. YYYY 
represents the calendar year, MM the 
month, and DD the day.

You can also specify a delimiter 
character for use between years, 
months, and days by selecting it from 
the [Pause Character] list box. The date 
below the list box shows the current 
date formatted with the selected 
character.

Viewer 
Resolution

Set the playback resolution.

Video quality is lower at AHalf ModeB 
and AQuarter ModeB, but playback 
response is better because these 
resolutions lower the burden on the 
decoder. These resolutions are 
recommended if your computer is not 
powerful enough to deliver smooth 
playback at Normal resolution.
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Shortcut Key List
This application supports keyboard shortcuts for many operations.

The following tables show keyboard shortcuts by menu. In the “Operation” column, the notation “command + N” indicates 
operations in which one key (in this case the Command key) is held down while pressing another key (in this case the N key).

� Notation for special keys
This manual uses the following notation to indicate special keys on the keyboard.

� JVC ProHD Clip Manager menu

� File menu

� Edit menu

Appendix (continue)

Symbol Notation in this manual Symbol Notation in this manual

command control

shift return

option

Command Operation Function Reference

Preference command + , Open the Options dialog of this application. A Page 43

Hide JVC ProHD Clip 
Manager

command + H Show or hide this application. ^

Hide Other option + command + H Show or hide other applications. ^

Quit JVC ProHD Clip 
Manager

command + Q Exit this application. A Page 26

Command Operation Function Reference

Rename option + command + R Rename the selected folder. A Page 32

Create New Folder shift + command + N Create a new folder in the selected media or folder. A Page 31

Open Containing 
Folder

command + N Start Finder and open the currently selected folder. A Page 32

Import shift + command + M Import MP4 file (unregistered clip). A Page 38

Command Operation Function Reference

Copy All option + command + C Copy all of the clips in the current media or folder. A Page 34

Cut command + X Cut the selected clip. A Page 36

Copy command + C Copy the selected clip. A Page 35

Paste command + V Paste a cut or copied clip. A Page 35

A Page 36

Delete command + delete Delete the selected clip. A Page 37

Select All command + A Select all of the clips in the current media or folder. ^

Properties command + I Open the Properties window of the selected clip. A Page 40

Split shift + command + W Split the selected folder into smaller folders of a specified size. A Page 33

Combine shift + command + J Combine specified folders into another folder. A Page 34

Special 
Characters

option + command + T Open the Character Palette so that you can enter special 
characters and symbols.

^
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� View menu

� Viewer menu

� Window menu

Command Operation Function Reference

Change Root Folder shift + option + command + W Change the root folder of the Tree View pane. A Page 31

Up command + P Moves up to the next folder. A Page 30

Sort By>Title shift + option + command + N Sort the clips in the List View pane in ascending or 
descending order by title.

A Page 28

Sort By>Size shift + option + command + S Sort the clips in the List View pane in ascending or 
descending order by size.

Sort By>Duration shift + option + command + D Sort the clips in the List View pane in ascending or 
descending order by duration.

Sort By>Date shift + option + command + C Sort the clips in the List View pane in ascending or 
descending order by date and time.

Search command + F Search for a clip. A Page 40

Command Operation Function Reference

Play Control>Play 5 or L Start play. A Page 29

Play Control>Stop Space or K Stop at the current position.

Play Control>Fast 
Forward

S Search in the forward direction (fast forward).

Play Control>Rewind A Search in the reverse direction (rewind).

Play Control>Jump To 
Head

Q Move to the first frame of the clip.

Play Control>Jump To 
End

W Move to the last frame of the clip.

Play Control>Next 
Frame

4 Step 1 frame forward.

Play Control>Previous 
Frame

3 Step 1 frame back.

View>Full Screen command + return Display in full-screen mode. A Page 39

Command Operation Function Reference

Minimize command + M Minimize the active window. ^

Play Control>Stop option + command + E Return the operating window to its default position and 
size.

A Page 28
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This product uses software subject to the GNU Lesser 
General Public License (LGPL).

Library name: FFMPEG

FFmpeg is a trademark of Fabrice Bellard, originator of the 
FFmpeg project.

Thank you for your purchase of this product.

This product uses the following software, which is subject 
to the LGPL. You have the right to obtain, modify and 
distribute the source code to this software.

FFMPEG

● avcodec-51.dll
● avformat-51.dll
● avutil-49.dll

The source code is contained in the /Software/
ClipManager/SRC folder of the bundled CD-ROM.

It may also be downloaded from the following web site.

http://www.jvc-victor.co.jp/download/lnx/06jvc_pro/
jvc_pro_linux_download_page.html

Please note that we cannot respond to inquiries regarding 
the content of the source code.
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